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The SavoyCAD System

Synonymous with quality SavoyCAD provides a simple, fast and effective
tool to create and edit drawings. It is not a replacement for more
powerful systems; on the contrary, SavoyCAD’s strength lies in its
simplicity. SavoyCAD is currently only available with AutoTrack.

What it can and can’t do
SavoyCAD can import and export DXF files making it suitable for editing
drawings created in other CAD systems. It supports lines, arcs,
polylines, lwpolylines, circles, text, blocks, inserts, etc. However, it is not
able to interpret all the types of data that may be stored in DXF files and
those elements that it cannot interpret will be lost. Therefore, if you are
using the DXF transfer feature to link to another CAD system we
recommend that you export only new and changed data.
SavoyCAD also includes built-in digitising tools allowing you to
electronically “trace” printed drawings. This feature is available on all
digitising tablets with WINTAB drivers.

Manual layout
Notation conventions
Throughout this manual key depressions are shown enclosed by angle
brackets thus enter <F> means type the letter F and <OR> means type
the letters O and R.
Menu options or commands are printed in a bold font.
Messages displayed by SavoyCAD are printed in italics.
Text that you should type and filenames are shown in a courier font.
All screen images and functionality descriptions are for SavoyCAD
running on Windows XP. The screen image may vary slightly on other
platforms. If functionality is different for other platforms the variations are
noted.

Mouse conventions
Windows allows mouse button functionality to be reversed for left handed
users. This manual refers to the default, right-handed, functionality. If
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you have configured your mouse for left handed operation then for left
mouse button read right mouse button and vice versa.

Getting help
If the user manual is not available try one of the alternatives.

Context sensitive on-line help
The extensive context sensitive on-line help mirrors the manual, but has
the powerful windows search facilities. To get help click the Help button
on any dialog or press F1.
Help is also available from the drop down menus:Select Help, SavoyCAD Help to get a structured breakdown of the help
text.
Select Help, About SavoyCAD to check the program module versions.

2  The SavoyCAD System
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Overview

General
The user interface follows conventions adopted by well designed
Windows software. At the top of the main window are the toolbars and at
the bottom is the command window. All can be displayed or not
according to user preference.
SavoyCAD has a multi-document interface (MDI) so you can edit more
than one file at a time allowing you to cut and paste data between
documents.

Menus
The drop down menus cannot be switched off. Other integrated Savoy
programs may appear with self-contained drop down menus to the right
of the CAD menus.

Toolbars
Many of the commands listed on the drop down menus are repeated on
toolbars. By default these are displayed below the drop down menus.

To switch toolbars on and off (Toolbars dialog)
(1420)

1. Select Toolbars from the View menu. The Toolbars dialog
will appear.
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Toolbars dialog
2. Tick the toolbars that you require and click OK.
3. Tick Large buttons to display oversized buttons.

To move a toolbar
1. The toolbars are by default docked at the top of the window
but can be moved to any location or docked on any window
edge. The toolbar positions are saved between sessions.
2. Move the cursor over the toolbar and, holding down the left
mouse button, drag the toolbar to the required location.
3. Release the mouse button when the toolbar is in position.
4. To dock a toolbar simply drag it over the window edge that you
want to dock it to.
5. To undock a toolbar simply drag it away from the window
edge.

To resize the command window
Just like the other toolbars, the command window can be located
anywhere on screen. However, unlike the others, it can also be resized.
Note that if it is docked then only one dimension can be changed. The
toolbar sizes are saved between sessions.
Resizing a docked command window
1. If you only want to change the height or width of a docked
window then move the cursor over the free edge until it
changes to a double ended arrow.
2. Now holding the left mouse button down drag the window
edge to the required size.
3. Release the button when the window is the desired size.
Resizing an undocked command window
1. You can adjust both height and width of an undocked
command window by moving the cursor over one of the
corners of the command window until it changes to a
diagonal double ended arrow.
2. Now holding the left mouse button down drag the corner to
the required position.
3. Release the button when the window is the required size.
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Tooltips
Reminders for what each button does appear as floating text adjacent to
each button as you move the cursor over them. At the same time a
reminder appears on the status line at the bottom of the CAD window.

Help
You can get help relating to a given screen by clicking on the help button,
pressing F1. If you do not have a dialog box open you may also type ?
on the command line to display help.
If there is no help specifically related to that screen you will see the
contents.
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File menu

File handling
SavoyCAD’s native file format is the SVC file. However, it can also open
or import DXF files from other CAD systems as well as ATX files from
AutoTrack and WTP files from WinTrack.

Opening vs Importing files
Files may be opened or imported. They may appear to do the same
thing but there is a difference:When you open a file, of any type, the contents will appear in a new CAD
window.
When you import a file, of any type, the contents will be added to those
currently being edited.
Note
SavoyCAD incorporates various features that apply specifically to
imported data and allow you display such entities in a single chosen
colour or prevent editing or selection of entities. You may therefore wish
to import a DXF file rather than open it simply to benefit from these
features.

To start a new drawing
New button

1. Select New from the File menu or click the New button on
the Standard toolbar or type NEW on the command line. A
new window will be created into which you may import data
or draw new entities.

To open a drawing file
Open button
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1. Select Open from the File menu or click the Open button on
the Standard toolbar or type OPEN on the command line.
The Open dialog will appear.
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Open dialog
2. Use the file browser to find the file you require and click open
to open it. The file will appear in the CAD window. If you
already have a drawing loaded SavoyCAD will open a new
window.
Remember
Opening a file, of any type, creates a new drawing window.

To save a drawing file
Save button

1. Select Save from the File menu or click the Save button on
the Standard toolbar or type SAVE on the command line.
2. If the drawing was loaded from disk, or had previously been
saved, the changes will be saved to the drawing file.
3. If the drawing was not loaded from disk, or had never been
saved, the Save As dialog will appear.

Save As dialog
4. Browse to locate the required directory, enter the File name
and click Save.
Warning
Save saves files in the new format to the original filename,
including extension. So to avoid overwriting non-SavoyCAD
files we recommend that you save the data as an SVC file
before making any changes. Thereafter you can safely use
Save which will save your data to your SVC format file.

8  File menu
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To save a copy of a file
1. Select Save As from the File menu or type SAVEAS on the
command line. The Save As dialog will appear.

Save As dialog
2. Browse to locate the required directory, enter the File name
and click Save.

To import a DXF, ATX or SVC file
1. Select Import from the File menu or type IMPORT on the
command line. The Import dialog will appear.

Import dialog
2. Select your required file type from the Files of type drop
down list.
3. Browse to find your file and click Open to open it.
Remember
Importing a file, of any type, adds it to the current drawing.

To export a DXF file
1. Select Export from the File menu or type EXPORT on the
command line. The Export dialog will appear.

User Manual for SavoyCAD

File menu  9

Export dialog
2. Select your required file type from the Save as type drop
down list bearing in mind the following:If your CAD system cannot read data in AutoCAD 2000
format then select AutoCAD R14 DXF format or AutoCAD
R12 format. AutoCAD R12 format is the most portable.
If you loaded a background in DXF format (whether you used
the Open or Import command) then we recommend that you
export only changes and new data (i.e. all data either created
or edited in SavoyCAD) by selecting the appropriate New
data in … DXF file type. The results can then be
superimposed on your original drawing in your CAD system.
If you did not import any DXF data or if you want to export all
the data then select the appropriate All data in … DXF file
type.
Note
The default file type will depend upon your Preferences
settings. Be careful to check that you are saving in the
correct format in case they have been changed by others.
3. Browse to locate the required directory, enter the File name
and click Save.

Last used file list
1. At the bottom of the File menu is a list of the most recently
loaded files (of any type). You can use these to quickly load
recently used files.
Note
Only opened or saved files appear in the last used file list
and accessing a file by selecting it in this way is always
treated as opening the file (rather than importing it).
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Previewing your printed output (Print Preview screen)
It is normally wise to check how your drawing will appear in printed form
especially if you are using expensive paper or ink.
1. Select Print Preview from the File menu. The screen will
change to show a representation of the output plot.

Print Preview
2. Use the Zoom In and Zoom Out buttons to examine the
output more closely.
3. Use the Next Page and Previous Page buttons to browse
between multi-page output.
4. Click the Two Page button to display two pages at once.
5. If you are satisfied click the Print button to set print options
and proceed.
Tip
If you cannot se anything in the print preview window make
sure that you have set the drawing units correctly. Go to
Tools, Preferences and select the correct units in the Scale /
Units window.
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Printing (Plotter / Printer Settings dialog)
Print button

1. Select Print from the File menu or click the Print button
on the Standard toolbar or type PRINT on the command
line. The Plotter / Printer Settings dialog will appear.
Note
This dialog is also accessible by clicking the Print button
on the Print Preview screen.

Plotter / Printer Settings dialog
2. Click the appropriate tab to edit or view the settings.
3. Make any changes that you want and click OK to print or
Cancel to abort. See Plotter / Printer Settings dialog.

12  File menu
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Printer / Plotter Settings: Print Settings (1310)
1. Click on the Print Settings tab.

Plotter / Printer Settings dialog: Print Settings tab
4. The default Printer, together with it’s Location (if known)
and Paper size are listed in the top window. Click the
Change button if you want to change any of these.
5. The Plot Border slider allows you to adjust the width of the
printed border.
6. By default SavoyCAD will scale the output to fit the paper
size. However, this means that it is likely to be a nonstandard engineering scale. If you want SavoyCAD to select
the best standard scale for you then set the Scale to (Auto
Select). If you want to print to a specific scale then select it
from the list.
2. Select the Area to plot as follows:Display to plot everything you can see in the CAD window.
Extents to plot the entire drawing.
Limits to plot everything within the drawing limits. Refer to
To set drawing limits to learn how to set limits.
Tablet area to plot everything that falls within the extents of
the three digitizing reference points. If you have not digitised
data then this option will default to Extents.
Window to plot everything within a specific window. Click
the Select button to specify the window. You may also set
this window by selecting Set Print Area from the File drop
down menu.
3. Set Orientation to Portrait or Landscape as appropriate for
your drawing.
7. Tick Plot in black only to print the drawing in black.
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8. Tick Ignore line types to print all lines as continuous.
9. Tick Ignore line weights to print all lines as thin as possible.
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Printer / Plotter Settings: Title Block (1320)
1. Click on the Title Block tab.

Plotter / Printer Settings: Title Block tab
2. Tick Include Title Block if you want to plot a title block
around the output.
10. Select the orientation of the title block. Note that this is
different from the paper orientation. A Horizontal title block
will be drawn across the bottom of the drawing sheet and a
Vertical title block will be drawn up the right hand side of the
sheet.
11. Tick the boxes that you want to appear in the title block.
Note that a box will be drawn for those ticked even if there is
no text defined. So, for example, you could print a Checked
By box for someone to sign manually later.
3. By default today’s date is entered in the Date field on new
drawings. To change the date click the Set Date button.
The Set Date dialog will appear.

Set Date dialog
4. Select Blank to leave the Date field blank.
Select Date Plotted to print the date it was printed.
Select File Date to print the last changed date of the project
file.
Select Custom Date if you want to specify a date to be
printed. You will then need to select a date by clicking the
arrow next to the date field.
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Printer / Plotter Settings: Notes (1300)
1. Click on the Notes tab.

Plotter / Printer Settings: Notes tab
2. Tick Notes if you want to add a notes area to your drawing.
3. Enter the text of the notes in the large text window.
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Drawing & editing

Fundamentals of drawing & editing
Selecting / deselecting objects
As you move the mouse over the drawing the object ‘closest’ to the
cursor will be highlighted. If you click the left mouse button while the
object is highlighted it will be selected. Selected objects have small
squares or ‘grips’ at key points and are collectively referred to as a
selection set. Objects may be added to the selection set by simply
selecting them, i.e. no need to hold down the shift or control key.
All selected objects may be deselected by clicking on the background.
The selection function is a toggle so an object may be deselected by reselecting it.
All commands operate on objects already selected.

Entering values
In most cases values may be entered either graphically or numerically.
Thus, for example, the radius of a circle may either be defined by
selecting a point on screen using the mouse or by typing a value on the
command line.
Where you can enter data numerically you will see a prompt on the
command line. For example the following command line prompt will
appear on starting to draw a line:Select start point:
This is asking for a coordinate which should be entered with commas
separating the values, thus:Select start point: 1,2
The prompt will then change to:Select end point:
You may enter points as absolute or relative cartesian coordinates, or as
absolute or relative polar coordinates. Absolute cartesian coordinates
are entered thus:Select end point: 3,4
To make these relative simply add an @ symbol before the values, thus:
Select end point: @3,4
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Polar coordinates (e.g. 3 units at an angle of 45 degrees) are entered
thus:Select end point: 3<45
To make these relative, add the @ symbol before the values, thus:Select end point: @3<45

Layers
Entities may be drawn on different layers allowing related objects to be
manipulated in groups. For example, an engineer might place drainage
on one layer, electrical on another and landscaping on another. This
would then allow the electrical and landscaping to be made invisible to
show just drainage.

Blocks & Inserts
Entities may be grouped together into Blocks which may then be inserted
into a drawing as entities in their own right. A block inserted into a
drawing is called an Insert. Blocks may themselves contain other
inserted blocks (or Inserts).
Blocks may also contain entities on multiple layers. When a block
containing entities on multiple layers is inserted into a parent drawing the
entities on these layers are placed on the layers with the same names in
the parent drawing, if they exist. If any of the layers do not exist in the
parent drawing they are created and the sub-entities placed on them.

Attributes
Entities have attributes including line type, line weight and colour which
may be specified in three ways,


Explicitly



ByBlock



ByLayer

If you want the attribute to remain the same regardless of how it is used
then you should specify that attribute explicitly.
If you want the attribute to be inherited from the properties of the layer on
which it is inserted then you should specify ByLayer.
If you want the attribute to be inherited from the parent block then you
should specify ByBlock.

Layer visibility options
Layer visibility can be controlled in one of two ways; either by switching
the layer off or by freezing the layer.
Freezing a layer makes all entities on the frozen layer invisible, as well as
sub-entities on other layers if their parent is on the frozen layer.
Switching a layer off makes all entities on the frozen layer invisible but
continues to display sub-entities if they exist on other non-frozen layers.
Note
Switching a layer off still requires SavoyCAD to consider the visibility of
entities within inserted bocks, so even if they turn out to be invisible, this
can result in slower redraws, on large drawings, than freezing the layer.

18  Drawing & editing
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Example
Consider a block called TREE containing two layers, LEAVES and
BRANCHES, inserted into a drawing on layer TREES. All layers are initially
on and thawed.
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If the layer TREES is frozen then the trees will all disappear
including all entities on the layers LEAVES and BRANCHES.



If, instead, the layer TREES is switched off then the entities
on layers LEAVES and BRANCHES will continue to be drawn.



If, instead the layer LEAVES is frozen then the leaves will
disappear but the branches will remain.



Finally, if the layer LEAVES is switched off then the leaves
will disappear but the branches will remain.
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Drawing
SavoyCAD can be used to create or edit most simple entities. A couple
of features are also available to improve usability. These allow you to
automatically repeat the last command and to automatically use the last
point drawn. These two options are described below.

To draw a point
Point button

1. Select Point from the Draw drop down menu or click
Point on the Draw toolbar or type POINT on the command
line. You will be prompted for the point.
2. Either select the Point using the mouse or type the
coordinates on the command line. The point will appear in
your chosen format (which may render it almost invisible!).
Note
You can change the appearance of point entities in the
Preferences dialog.

To draw a line

Line button

1. Select Line from the Draw drop down menu or click Line
on the Draw toolbar or type LINE on the command line.
You will be prompted for the start point.
2. Either select the Start point using the mouse or type the
coordinates on the command line. The point will be
placed and a line displayed connecting it to the cursor
position. You will be prompted for the end point.
3. Either select the End point using the mouse or type the
coordinates on the command line. The line will appear
selected.

To draw a polyline

Polyline button

1. Select Polyline from the Draw drop down menu or click
Polyline on the Draw toolbar or type PLINE on the
command line. You will be prompted for the start point.
2. Either select the Start point using the mouse or type the
coordinates on the command line. The point will be
placed and a line is displayed connecting it to the cursor
position. You will be prompted to enter the next point or
switch to arcs or close the polyline.
3. If you want to draw another line segment:Either select the Next point using the mouse or type the
coordinates on the command line.
If you want to start an arc:Type A (for arc) on the command line. The line connecting
the last point to the cursor will change to an arc and the
command line prompt will change. Now, either select the
end point using the mouse or type the coordinates on the
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command line.
If you want to join the line back to the first point:Type C (for close) on the command line. A line will be
drawn connecting the last point back to the start.
If you want to revert to drawing line segments:Type L (for line) on the command line. The arc connecting
the last point to the cursor will change to a line and the
command line prompt will change. Now, either select the
Next point using the mouse or type the coordinates on
the command line.
4. Repeat step 3 until you have drawn the entire polyline.
5. Click the right mouse button or hit Esc to cancel the
polyline command. The polyline will appear selected.

To draw a circle
Circles can be drawn in two ways; by defining three points on the
circle or by defining the centre and radius.

To draw a 3-Point Circle
3-Point Circle button

1. Select Circle: 3 Points from the Draw drop down menu or
click 3-Point Circle on the Draw toolbar or type
CIRCLE3P on the command line. You will be prompted for
the first point.
2. Either select the First point using the mouse or type the
coordinates on the command line. At this stage nothing
will be visible. You will be prompted for the second point.
3. Either select the Second point using the mouse or type
the coordinates on the command line. Now you should
see a circle drawn through the two defined points which
changes radius and position as you move the cursor. You
will be prompted for the third point.
4. Either select the Third point using the mouse or type the
coordinates on the command line. The full circle will now
appear selected.

To draw a Centre/Radius Circle
Centre/Radius button

1. Select Circle: Centre / Radius from the Draw drop down
menu or click Centre/Radius Circle on the Draw toolbar
or type CIRCLE on the command line. You will be
prompted for the centre of the circle.
2. Either select the Centre using the mouse or type the
coordinates on the command line. A circle will appear
whose radius changes as you move the mouse. You will
be prompted for the radius of the circle.
3. Either select the Radius using the mouse or type a value
on the command line. The circle will now appear selected.

User Manual for SavoyCAD

Drawing & editing  21

To draw an arc
Arc button

1. Select Arc: 3 Points from the Draw drop down menu or
click Arc on the Draw toolbar or type ARC on the
command line. You will be prompted for the start point.
2. Either select the Start point using the mouse or type the
coordinates on the command line. At this stage nothing
will be visible. You will be prompted for the middle point.
3. Either select the Middle point using the mouse or type the
coordinates on the command line. An arc will appear
whose shape changes as you move the mouse. You will
be prompted for the end point.
4. Either select the End point using the mouse or type the
coordinates on the command line. The completed arc will
appear selected.

To draw an ellipse
Ellipse button

1. Select Ellipse from the Draw drop down menu or click
Ellipse on the Draw toolbar or type ELLIPSE on the
command line. You will be prompted for the centre of the
ellipse.
2. Either select the Centre of the ellipse using the mouse or
type the coordinates on the command line. At this stage
nothing will be visible. You will be prompted for the major
axis point.
3. Either select the Major axis point using the mouse or
type the coordinates on the command line. At this point
an ellipse will appear whose shape changes as you move
the cursor. You will be prompted for the minor axis point.
4. Either select the Minor axis point using the mouse or
type the coordinates on the command line. The
completed ellipse will appear selected.
Note
Although the ends of the axes are requested in a particular
order (major axis first), you may select a minor axis point
that makes it the longer of the two.

To draw text
Text button

1. Select Text from the Draw drop down menu or click Text
on the Draw toolbar or type TEXT on the command line.
You will be prompted to enter the text you want to add.
2. Type the Text on the command line. You will be prompted
for the Insertion point.
3. Either select the Insertion point using the mouse or type
the coordinates on the command line. You will be
prompted for the text height.
4. Either select the text Height using the mouse or type the
height on the command line. You will be prompted for the
rotation angle.
5. Either select the Rotation using the mouse or type the
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angle on the command line. The text will appear.
Note
Angles are measured in degrees anti-clockwise from a
zero datum facing East.

To automatically repeat the last command
Auto-repeat Last Draw
Command button

1. Select Repeat Last Draw Command from the Draw drop
down menu or depress the Repeat Last Draw Command
button on the Draw toolbar or type REPEAT on the
command line. With this mode enabled the same draw
command is invoked every time you click the left mouse
button.
2. To cancel simply hit Esc.
3. The option is a toggle so to disable the mode simply select
Repeat Last Draw Command again.

To automatically use the last point drawn
Auto-use Last Point Drawn
button

1. Select Reuse Last Drawn Point from the Draw drop
down menu or depress the Reuse Last Drawn Point
button on the Draw toolbar or type REUSE on the
command line. With this mode enabled all the draw
commands take the last point drawn as their first input no
matter how long ago the last point was drawn.
Note
If you enable both Reuse Last Drawn Point and Repeat
Last Draw Command, the Line command is identical to
drawing a polyline.
2. To cancel simply hit Esc.
3. The option is a toggle, so to disable the mode simply
select Reuse Last Drawn Point again.

To explode a polyline
1. Select Explode from the Draw drop down menu or type
EXPLODE on the command line. Alternatively, select the
polylines and then select Explode. You will be prompted to
select the entities to be exploded.
2. Select the polylines and right click to confirm. The polylines
will be exploded into their constituent line and arc entities.
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Editing
Any drawn entity can be moved, copied, rotated, resized or reshaped and
deleted. Although, in the following descriptions we select the object(s)
before the command you may select the command first if you prefer.

To view the properties of an object (Properties
dialog) (1400)
1. Select the object(s).
Properties button

2. Select Properties from the Edit drop down menu or click
the Properties button on the Object Properties toolbar or
type PROPERTIES on the command line. The Properties
dialog will appear.

Properties dialog
3. Change the layer that the object is on by clicking the
Layer drop down list. If you edit one of the layer attributes
or create a new layer then click the Layers adjacent to the
drop down list. This will display the Maintain Layers
dialog.
4. Select the entity colour from the Colour drop down list.
5. Select the entity linetype from the Linetype drop down list.
If you want to edit a linetype or create a new one then click
the Linetypes button adjacent to the drop down list.
6. Enter the linetype Scale to adjust the length of the linetype
pattern.

To view the coordinates of an object (List
command)
1. Select List from the Edit drop down menu or type LIST on
the command line. You will be prompted to select the
objects to be listed.
2. Select the objects using the mouse and right click when you
have finished. Alternatively you may select the entitites and
then select the list command.
3. Detailed information for each selected entity will be displayed
in the command window.
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To move an object
1. Select Move from the Edit drop down menu or type MOVE on
the command line. You will be prompted to select the
objects to be moved.
2. Select the object(s) using the mouse and right click to
confirm. You will be prompted for the base point.
Alternatively, you could select the objects first and then
select the Move command. You will be prompted for the
base point.
3. Select the Base point using the mouse or type the
coordinates on the command line. You will be prompted for
the destination point.
4. Select the Destination point using the mouse or type the
coordinates on the command line. Remember it’s relative to
the base reference point which is not necessarily the same
as the object location. The object will appear in its new
location.
Note
The use of a base reference point enables you to move
objects using known distances from other locations in the
drawing.
5. An alternative way to move individual objects is to select it’s
green grip and drag it to the new location.

To copy an object
1. Select Copy from the Edit drop down menu or type COPY on
the command line.
2. Select the objects(s) using the mouse and right click to
confirm. You will be prompted for the base point.
Alternatively, you could select the objects first and then
select the Copy command. You will be prompted for the
base point.
3. Select the Base point using the mouse or type the
coordinates on the command line. You will be prompted for
the destination point.
4. Select the Destination point using the mouse or type the
coordinates on the command line. Remember it’s relative to
the base reference point which is not necessarily the same
as the object location. The object will appear in its new
location.
Note
The use of a base reference point enables you to copy
objects using known distances from other locations in the
drawing.
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To rotate an object
1. Select Rotate from the Edit drop down menu or type ROTATE
on the command line.
2. Select the object(s) using the mouse and right click to
confirm. You will be prompted for the base point.
Alternatively, you could select the objects first and then
select the Rotate command. You will be prompted for the
base point.
3. Select the Base point using the mouse or type the
coordinates on the command line. You will be prompted for
the rotation angle.
4. Select the Angle using the mouse or type a value on the
command line. The object(s) will appear in their new
orientation.

To delete an object
1. Select Delete from the Edit drop down menu or type DELETE
on the command line.
2. Select the object(s) to be deleted using the mouse and right
click to confirm. The objects will be deleted immediately.
Alternatively you could select the objects first and then select
the Delete command. The objects will be deleted
immediately.
3. You can also delete selected objects by pressing the
<Delete> or <Del> key on your keyboard.
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Grip editing
Most entities can be edited individually using their editing grips. Every
entity has a move grip, that may be used to move the object, and all
basic entities have other editing grips that may be used to adjust the
shape or size of the object.

GripTips
1. By default all grips have associated text showing the
coordinates, the type of entity and the use of the grip. This
text is called a GripTip. GripTips can be toggled on and off in
(1510)
the Preferences: Display
dialog.

To move an object using grips
1. Select the object to be moved. One or more grips should
appear on the object.
Note
If you cannot see them you may have the grip symbol size
set too small or the grip colour set to an inappropriate colour.
You may change either of these in Preferences, Display.
2. Select the move grip. This is coloured green by default but
may have been changed. To check the move grip colour go
to Preferences, Display. You will be prompted to move the
object.
3. Select the new location for the object using the mouse. The
object will appear in the new location.

To resize / reshape an object
1. Select the object to be resized or reshaped. One or more
grips should appear on the object.
Note
If you cannot see them you may have the grip symbol size
set too small or the grip colour set to an inappropriate colour.
You may change either of these in Preferences, Display.
2. Select one of the editing grips to change the shape of the
object. These are coloured blue by default but may have
been changed. To check the editing grip colour go to
Preference, Display.
The change made by moving the grip depends upon the
object being edited. Thus:On a line it will move the end point.
On a polyline it will move the individual vertex.
On a circle it will change the radius.
On an arc it will change the radius and/or centre.
On the first defined axis of an ellipse it will change the
orientation and/or size, and on the second defined axis it will
change the major/minor axis proportion.
You cannot edit inserted blocks.
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Blocks & Inserts
You may group entities together into Blocks. These blocks may be
inserted into your drawing and used just like the basic drawing entities.

To create a block
1. First draw the entities that you want to include in the block.
2. Make sure that no entity selected.
3. Now select Block from the Draw drop down menu or type
BLOCK on the command line. You will be prompted for the
block name.
4. Type the Name on the command line.
Note
You may not use certain characeters in the block name.
5. If a block with this name already exists you will be prompted
for another name. Otherwise, you will be prompted for the
origin point.
6. Either select the Origin point using the mouse or type the
coordinates on the command line. This is the point that you
will use to position the block when you insert it and the point
about which you may rotate it. You will be prompted to
select the objects to include in the block.
7. Select the objects for inclusion using the mouse in the
normal way.
8. When you have finished selecting objects right click to end
the command. The objects will disappear.

To insert a block
1. Select Insert from the Draw drop down menu or type
INSERT on the command line.
2. If there are no blocks currently defined you will be warned.
Otherwise, you will be asked to enter the name of the block
you want to insert.
3. Type the Name on the command line. If you cannot
remember the name type ? to see a list of currently defined
blocks and then type the name at the prompt. You will be
prompted for the insertion point.
4. Either select the Insertion point using the mouse or type the
coordinates on the command line. You will be prompted for
the X Scale, the scale in the X direction.
5. Either select the X Scale using the mouse or type the value
on the command line or press return to accept the default of
1. You will be prompted for the Y Scale.
6. Either select the Y Scale using the mouse or type the value
on the command line or press return to accept the default of
1. You will be prompted for the rotation.

28  Drawing & editing

User Manual for SavoyCAD

7. Either select the Rotation using the mouse or type the value
on the command line. The block will appear.
Note
Rotation is measured in degrees anti-clockwise from East.

To explode a block
1. Select Explode from the Draw drop down menu or type
EXPLODE on the command line. You will be prompted to
select the object(s) to explode.
2. Select the objects using the mouse and right click to confirm.
Alternatively, you could select the objects first and then
select the Explode command.
3. The objects will be exploded into their constituent entities.
Note
Any nested blocks inserted into the exploded block will need
to be exploded.
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Editing Properties

The Properties toolbar contains layer, line type, line weight and colour
controls. It is shown here in three rows in the interests of clarity.

Properties toolbar

Layers list
The layers list shows the name and status of the current layer or, if an
entity is selected, the layer and status of the selected entity.

Layers list
If you select several entities the Layers list will display the layer name if
all the selected entities are on the same layer. Otherwise it will show
nothing.

To move an object to another layer
1. Simply select the object(s) to be moved.
2. Select the layer you want to move them to from the Layers
drop down list. All the selected entities will be updated
immediately.

To make a layer invisible
1. Make sure that no objects are selected and then select the
layer that you want to make invisible.
On / Off icons

Freeze / Thaw icons
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2. Now you have two options, either switch the layer off, or
freeze it.
To switch the layer off, click the on/off icon so that it goes
out, and vice versa.
To freeze the layer, click the freeze/thaw icon so that it
changes to a snowflake, and vice versa.
Refer to Layer visibility options for an explanation of the
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difference.
3. In AutoCAD, frozen layers are not regenerated whereas
layers that are switched off are regenerated but not drawn.

To stop a layer from being printed
1. Make sure that no objects are selected and then select the
layer that you want to make view only.
Plot / No Plot icons

2. To make the layer view only, click the plot/noplot icon so that
the green light changes to red, and vice versa.

To make a layer non-editable
1. Make sure that no objects are selected and then select the
layer that you want to make non-editable.
Lock / Unlock icons

2. To lock the layer, click the lock/unlock icon so that it appears
closed, and vice versa.

To change to colour of a layer
1. Make sure that no objects are selected and then select the
layer whose colour you want to change.
2. Now, simply click on the colour swatch and select the new
colour from the palette displayed.
Note
Objects changing the colour of a layer will only affect those
objects with colour set to ByLayer.

To change a layer’s name
Layers button

1. You can only change a layer’s name in the Maintain Layers
dialog. Click on the Layers button. See Maintain Layers
dialog.

To create a new layer
Layers button
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1. Select Layers from the View menu or click the Layers button
on the Properties toolbar or type LAYERS on the command
line. The Maintain Layers dialog will appear. Refer to
Maintain Layers dialog.
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Maintain Layers dialog (1000)
Layers allow you to group entities together and control attributes such as
visibility and colour. Each layer has attributes associated with it that are
used if you select ByLayer for the entity.
Layers button

1. Select Layers from the View menu or click the Layers button
on the Properties toolbar or type LAYERS on the command
line. The Maintain Layers dialog will appear.

Maintain Layers dialog
2. The main window lists the layers that currently exist in the
drawing. The Current layer, the one on which new entities
will be drawn by default, is shown in the text box at the top.
3. Highlight the layer that you want to edit.
4. Edit the Name as necessary.
5. Select the pen colour from the drop down list. If you want to
use a colour that is not listed then select Custom and click in
the colour swatch to select the colour.
6. Select the required linetype from the drop down list. If you
want to create a new linetype then click the Linetype button
to display the Linetypes dialog. Once the new linetype has
been created, select it from the drop down list.
7. Tick On to switch the selected layer on.
8. Tick Frozen to freeze the selected layer.
9. Tick Plot to ensure that all entities on the selected layer plot.
10. Tick Locked to prevent accidental changes to entities on the
current layer.

User Manual for SavoyCAD

Editing Properties  33

To create a new layer
Layers button

1. Select Layers from the menu or click the Layers button on
the Properties toolbar or type LAYERS on the command line
to display the Maintain Layers dialog.
2. Click the New button.
3. A new layer with the default name NewLayer will be created.
4. You may edit the name and change the associated colour
and linetype using the edit boxes below the list.

To change the current layer
Layers button

1. Select Layers from the Properties menu or click the Layers
button on the View toolbar or type LAYERS on the command
line to display the Maintain Layers dialog.
2. Highlight the layer you want to make current and click the
Make Current button. The name of the layer will appear in
the top edit box.

To delete a layer
Layers button

1. Select Layers from the Properties menu or click the Layers
button on the View toolbar or type LAYERS on the command
line to display the Maintain Layers dialog.
2. Highlight the layer you want to delete and click the Delete
button.
Note
You cannot delete the current layer or layers that still contain
entities.
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Linetypes list
The Linetypes list shows the current linetype or, if an entity is selected,
the colour of that entity.

Linetypes list
If the linetype is set to By Layer then the indicator will show the linetype
of the layer. Likewise if it is set to By Block it will show the linetype of
the parent block.
If you select several entities the Linetypes list will display the linetype if all
the selected entities are set to the same linetype. Otherwise it will show
nothing.
Note
If selected entities are set to By Layer then even if the linetypes of the
layers are different the linetype will still appear as By Layer. However,
the linetype indicator will show the linetype of the first entity selected.

To change the linetype of an entity
1. Select the object(s) whose linetype you want to change.
2. Select the new linetype from the Linetypes list. All the
selected entities will be updated immediately.
Select a pen colour from the list to set the linetype explicitly
to one of the preset values.
Select By Layer if you want to be able to control the linetype
of the object by changing the linetype of the layer.
Select By Block if you want to be able to change the linetype
of the object by changing the linetype of the parent block.

To create a new linetype
Linetypes button
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1. Select Linetypes from the View menu or click the Linetypes
button on the Properties toolbar or type LINETYPES on the
command line. The Maintain Linetypes dialog will appear.
Refer to Maintain Linetypes dialog.
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Maintain Linetypes dialog (1100)
Linetypes can be created or edited in the Linetypes dialog.
Linetypes button

1. Select Linetypes from the View menu or click the Linetypes
button on the Properties toolbar or type LINETYPES on the
command line. The Maintain Linetypes dialog will appear.

Maintain Linetypes dialog
2. The layers that exist in the current drawing are listed in the
main window. Above that the Current linetype is displayed.
New entities are drawn in the current linetype.
3. The Global Linetype Scale allows you to adjust the overall
length of the pattern of all linetypes in the current drawing.
You might use this to scale all your linetypes from millimetres
to metres.
4. The Entity Linetype Scale allows you to adjust the linetype
scale for each entity.
5. Below the main window are listed the details of the
highlighted linetype, i.e. the one under the cursor.
6. The Name is used to select the linetype and appears in the
linetype drop down list.
7. The Description is free format and users may enter either a
text description or, as is often the case, a visual reminder
using standard keyboard characters.
8. Below these fields are fields for the Dash Lengths and Gap
Lengths. The line format starts with the first dash length
followed by the first gap length, then the second dash length,
and so on.
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To create a new linetype
Linetypes button

1. Select Linetypes from the View menu or click the Linetypes
button on the Properties toolbar or type LINETYPES on the
command line. The Maintain Linetypes dialog will appear.
2. Click the New button. A new linetype with a default name
NewLineType will be added to the list.
3. Edit the Name to reflect the style of the line. Try to make this
name self explanatory and not too long.
4. You may enter a Description if you wish. This may either be
a simple text description or a more visual description using
keyboard characters, thus:___ .. ___ .. ___
5. Enter the first Dash length in drawing units followed by the
first Gap length. With just one dash and one gap of the
same lengths the line will appear as a simple dashed line
similar to this:___ ___ ___ ___
6. Enter the second Dash length and Gap length to create a
more complex linetype such as this:____ _ ____ _ ____
7. Enter further values to generate even more complex
linetypes but make sure that you always end on a gap length.

To change the current linetype
Linetypes button

1. Select Linetypes from the Properties menu or click the
Linetypes button on the View toolbar or type LINETYPES on
the command line to display the Maintain Linetypes dialog.
2. Highlight the linetype you want to make current and click the
Make Current button. The name of the linetype will appear
in the top edit box.

To delete a linetype
Linetypes button

1. Select Linetypes from the Properties menu or click the
Linetypes button on the View toolbar or type LINETYPES on
the command line to display the Maintain Linetypes dialog.
2. Highlight the linetype you want to delete and click the Delete
button.
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Colours list
The colours list shows the current colour, or, if an entity is selected, the
colour of that entity.

Colours list
If the colour is set to By Layer then the colour swatch will indicate the
colour of the layer. Likewise if it is set to By Block it will indicate the
colour of the parent block.
If you select several entities the Colours list will display the colour if all
the selected entities are set to the same colour. Otherwise it will show
nothing.
Note
If selected entities are set to By Layer then even if the colours of the
layers are different the colour will still appear as By Layer. However, the
colour swatch will indicate the colour of the first entity selected.

To change the colour of an object
1. Select the object(s) whose linetype you want to change.
2. Select the new linetype from the Linetypes list. All the
selected entities will be updated immediately.
Select a pen colour from the list to set the colour explicitly to
one of the 255 preset colours.
Select Custom if you want to use a colour that is not listed.
Then click on the colour swatch to select the colour.
Select By Layer if you want to be able to control the colour
of the object by changing the colour of the layer.
Select By Block if you want to be able to change the colour
of the object by changing the colour of the parent block.
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Line Weights list
The Line Weights list shows the current colour, or, if an entity is selected,
the line weight of that entity.

Line Weights list
If the line weight is set to By Layer then the colour swatch will indicate
the colour of the layer. Likewise if it is set to By Block it will indicate the
colour of the parent block.
If you select several entities the Line Weights list will display the line
weight if all the selected entities are set to the same line weight.
Otherwise it will show nothing.
Note
If selected entities are set to By Layer then even if the line weights of the
layers are different the colour will still appear as By Layer. However, the
line weight indicator will show the weight of the first entity selected.

To change the line weight of an entity
1. Select the object(s) whose line weight you want to change.
2. Select the new line weight from the Line Weights list. All the
selected entities will be updated immediately.
Select a line weight from the list to set the line weight
explicitly to one of the preset values.
Select By Layer if you want to be able to control the line
weight of the object by changing the line weight of the layer.
Select By Block if you want to be able to change the line
weight of the object by changing the line weight of the parent
block.
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Changing the view

The view of the drawing can be rotated, magnified and panned to make it
easy to make changes. All the view adjustments are available on the
View drop down manu or on the View toolbar.

View toolbar

To redraw all entities
Redraw button

1. Select Redraw from the View drop down menu or click the
Redraw button on the View toolbar or type REDRAW on the
command line.

To zoom in
Zoom In button

1. Select Zoom, In from the View drop down menu or click the
Zoom In button on the View toolbar or type ZOOM IN (or the
abbreviation Z I) on the command line. A window with the
same proportions as the CAD window will appear. This
represents what you will see with that level of zoom. You will
be prompted for the centre point.
2. Use the scroll wheel on your mouse (if it has one) to adjust
the size of the window and move the cursor to adjust the
location of the zoom window.
3. Select the Centre point using the mouse or type the
coordinates on the command line. The CAD window will be
redraw to show the new display extents.

To zoom out
Zoom Out button
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1. Select Zoom, Out from the View drop down menu or click
the Zoom Out button on the View toolbar or type ZOOM OUT
(or the abbreviation Z O) on the command line. The zoom
level will halve, i.e. the visible length and width displayed will
double.
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To zoom to a specific area
Zoom Window button

1. Select Zoom, Window from the View drop down menu or
click the Zoom Window button on the View toolbar or type
ZOOM WINDOW (or the abbreviation Z W) on the command
line. You will be prompted for the first corner point.
2. Select the First corner point using the mouse or type the
coordinates on the command line. A rectangular dotted
window will appear whose corners are the point just specified
and the cursor. This represents what you will see with that
level of zoom. You will be prompted for the second corner
point.
3. Select the Second corner point using the mouse or type the
coordinates on the command line. The window will be
redrawn to show the new display extents.

To zoom to the drawing extents
Zoom Extents button

1. Select Zoom, Extents from the View drop down menu or
click the Zoom Extents button on the View toolbar or type
ZOOM EXTENTS (or the abbreviation Z E) on the command
line.

To zoom to the drawing limits
Zoom Limits button

1. Select Zoom, Limits from the View drop down menu or click
the Zoom Limits button on the View toolbar or type ZOOM
LIMITS (or the abbreviation Z L) on the command line.

To zoom to the tablet limits
Zoom Tablet button

1. Select Zoom, Tablet from the View drop down menu or click
the Zoom Tablet button on the View toolbar or type ZOOM
TABLET (or the abbreviation Z T) on the command line.

To go back to the previous zoom window
Zoom Previous button

1. Select Zoom, Previous from the View drop down menu or
click the Zoom Previous button on the View toolbar or type
ZOOM PREVIOUS (or the abbreviation Z P) on the command
line. The previous view will be redisplayed if there is one.
The command can be used repeatedly.

To go forward to the next zoom window
Zoom Next button
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1. Select Zoom, Next from the View drop down menu or click
the Zoom Next button on the View toolbar or type ZOOM
NEXT (or the abbreviation Z N) on the command line. The
next view will be redisplayed if there is one. The command
can be used repeatedly.
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To pan across the the drawing
Pan button

1. Select Pan from the View drop down menu or click the Pan
button on the View toolbar or type PAN on the command line.
You will be prompted to enter the base point.
2. Select the Base point using the mouse or type the
coordinates on the command line. A dotted window of the
same size and shape as your CAD window will appear. This
represents what you will see with that degree of pan. You
will be prompted for the destination point.
3. Select the Destination point using the mouse or type the
coordinates on the command line. The window will be
redrawn to show the new display extents.

To rotate the drawing
Rotate button

1. Select Rotate from the View drop down menu or click the
Rotate button on the View toolbar or type VIEWROTATE on
the command line. A line will appear connecting the centre
of the screen to the cursor pointer.
2. Move the mouse to adjust the required rotation angle and
click to confirm. Note that the zero datum is horizontally to
the right, i.e. facing East, and positive rotation is anticlockwise.

To reset any rotation
Reset Rotation button

1. Select Reset Rotation from the View drop down menu or
click the Reset Rotation button on the View toolbar or type
VIEWROTATERESET on the command line. Any drawing
rotation will be reset to zero.

To set drawing limits
1. Select Set Limits from the View drop down menu.
2. Use the mouse to select a window representing the drawing
limits.
3. The drawing limits may be used when printing your drawing.
See Printer / Plotter Settings: .

To clear drawing limits
1. Select Clear Limits from the View drop down menu.
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Tools

This chapter covers the various tools built into SavoyCAD to make the
drawing and editing process easier.

Grid
A rectangular grid can assist in aligning objects and in estimating
distances.

To display a grid
Show Grid button

1. Select Show Grid from the Tools drop down menu or click
on the Show Grid button on the Tools toolbar or type GRID
on the command line. A rectangular grid pattern will appear
over the CAD window. If no grid appears the grid spacing
may be set too small or too large. If the spacing is set too
large then the grid markers may be outside the displayed
area. If it is set too small then SavoyCAD does not display it.
2. The command is a toggle so select it again to switch it off.
The toolbar button remains down if the grid is switched on.

To change the grid spacing
Refer to Preferences: Grid / Snap.

To change the grid colour
Refer to Preferences: Display.

Snap grid
It is sometimes useful, when drawing repeating elements, to be able to
snap to a grid pattern. The snap grid allows this and is independent of
the normal grid described above. This command is also quite separate
from the object snap modes described elsewhere.

To snap to the snap grid
Snap to Grid button
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1. Select Snap to Grid from the Tools drop down menu or click
on the Snap to Grid button on the Tools toolbar or type
SNAP on the command line. The cursor will now snap to the
invisible snap grid.
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Tip
Althought the snap grid is invisible you can of course set the
grid spacing and origin to match the snap grid.
2. The command is a toggle so select it again to switch it off.
The toolbar button remains down if snap is switched on.

To change the snap grid origin or spacing
Refer to Preferences: Grid / Snap.

To change the snap grid colour
Refer to Preferences: Display.

Orthogonal mode
Orthogonal mode is useful when you need to draw precisely vertical and /
or horizontal lines at a arbitrary positions.

To enable orthogonal mode
Orthogonal Mode button

1. Select Orthogonal Mode from the Tools drop down menu or
click on the Orthogonal Mode button on the Tools toolbar or
type ORTHOGONAL on the command line.
2. The command is a toggle so click it again to switch it off.
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Object Snap modes (Object Snap Modes dialog) (1200)
Snap modes make drawing objects easier by selecting points when you
get within a preset distance or tolerance. The types of points (or snap
modes) that you may use include the centres of circles, the ends of lines
or arcs, and tangent points. You can select which, if any, snap modes
you want to activate and can change them at any time.
The snap modes are controlled by the Object Snap Modes dialog and / or
the Snap toolbar.
1. Select Object Snap Modes from the Tools drop down menu.
The Object Snap Modes dialog will appear.

Object Snap Modes dialog
2. Select the modes that you want active.
Tip
The quickest and easiest way to switch snap modes on and
off is to depress the appropriate button on the Object Snap
toolbar. If the button is down the snap mode is active and
vice versa.
Object Snap toolbar

3. You can adjust the snapping distance using the Snap
Tolerance slider. Move the slider to the right to make the
snap window larger, i.e. the cursor will snap to a point from
further away.
4. Click OK to confirm your changes and close the dialog or
Cancel to abort and close the dialog.

More on object snap modes
There is an order of precedence for the snap modes so that for example
a nearest point will be snapped to before a perpendicular point. Note that
the snap point will be offered for an entity when the cursor is within the
snap tolerance distance of a visible part of that entity and not when it is
close to the snap point itself. Thus, for example, a centre point snap will
be offered when the cursor is close to the perimeter of a circle and not
when it approaches the actual centre point.
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Nearest Point
Snap to Nearest Point
button

The cursor snaps to the nearest point on the nearest entity. Applies to all
entities.

End Point
Snap to End Point button

Cursor snaps to the nearest end of the entity. Applies only to lines,
polylines and arcs.

Mid Point
Snap to Midpoint button

Cursor snaps to the mid point on the entity. Applies only to lines,
polylines and arcs.

Centre Point
Snap to Centre button

Cursor snaps to the centre of the entity. Applies only to Circles, Arcs and
Ellipses. Note that the centre point will be snapped when the cursor is
close enough to any visible part of one of these entities not when it is
close to the centre point itself.

Intersection Point
Snap to Intersection
button

Cursor snaps to the intersection between two entities. Applies to
intersections between all entities.

Tangent Point
Snap to Tangent button

Cursor snaps to the point on the entity at which a line drawn from the
current point would intersect tangentially. Applies only to circles, arcs
and ellipses.
Note
This snap mode can only be used when the other end of the entity is
fixed.

Perpendicular Point
Snap to Perpendicular
button

The cursor snaps to the point on the entity at which a line drawn from the
current point would intersect at right angles. Applies to all entities. If the
perpendicular point occurs on the extension of a line no snap point will be
offered.
Note
This snap mode can only be used when the other end of the entity is
fixed.
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Measuring distances (Distance command)
Distance button

1. Select Distance from the Tools drop down menu or click the
Distance button on the Tools toolbar or type DISTANCE on
the command line. You will be prompted to select the start
point that you wish to measure from.
2. Select the Start point using the mouse or type the
coordinates on the command line. You will be prompted to
select the end point that you wish to measure to.
3. Select the End point using the mouse or type the
coordinates on the command line. The distance between the
two points will appear similar to the following:Distance = 46.505105m
Distance = 46.505105
DX = -45.674044
DY = 8.752515
The first value, Distance, is the absolute distance between
the two points “as the crow flies” in real world units. This
value is calculated using the Drawing Scale set in
Preferences, General.
The second value for Distance is again the absolute
distance between the two points but expressed in drawing
units. Unless you are drawing to a scale other than 1:1 these
two values will be the same.
The third value, DX, is the difference between the X ordinates
of the start point and the end point.
The fourth value, DY, is the difference between the Y
ordinates of the start point and end point.
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Listing entity details (List command)
1. Select List from the Tools drop down menu or type LIST on
the command line. You will be prompted to select the
objects you wish to list.
2. Select the object(s) and right click to confirm.
Alternatively, you could select the objects first and then
select the List command.
3. Each entity will be listed in a format similar to the following:Entity
Layer
Linetype
Linetype Scale
Colour (RGB)
Closed
Start Point
End Point

:
:
:
:
:
:
:
:

Line
HT_HOUSES
CONTINUOUS
1.00
255,0,0
No
56.3400,23.3220,0.0000
23.3420,12.5670,0.0000

The first five of these always appear. The remainder are
specific to the entity type.
4. Block inserts are listed as follows:Entity
Layer
Linetype
Linetype Scale
Colour (RGB)
Block
Insert Point
Scale X
Scale Y
Scale Z
XY Rotation

:
:
:
:
:
:
:
:
:
:
:

Insert
HT_DRIVES_HATCH
DASHED
1.00
255,0,0
W123D65X
12.4567,43.7865,0.000
-1.0000
1.0000
1.0000
34.7898

Notice in the above listing that the Scale X value of -1
indicates that the block was flipped or mirrored about the Xaxis upon insertion.
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Preferences (Preferences dialog)
You can customise the way SavoyCAD works by changing your
preferences.
1. Select Preferences from the Tools drop down menu. The
Preferences dialog will appear.

Preferences dialog
2. Click the appropriate tab to edit or view your preferences.
3. Edit the data as required and click OK to confirm when you
are satisfied. Click Cancel to abort all changes and close
the Preferences dialog.
4. The Display and Zoom settings are saved between sessions
and may be reset to defaults by clicking the Reset button.
The other settings are only saved for the duration of the
session.
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Preferences: General (1500)
1. Click on the General tab.

Preferences dialog: General tab
12. Tick Allow imported entities to be edited if you want to be
able the edit entities in imported DXF files.
13. Tick Allow imported entities to be selected / snapped to if
you want to be able to select or snap to imported entities.
14. It is sometimes useful to be able to distinguish between
imported data (of any type, DXF, WTP or ATX) and newly
drawn entities. By default imported entities are drawn in the
respective colours but you may force them all to appear in
single colour by ticking Draw imported entities in a single
colour. You may then set the colour on the Display tab.
15. When a DXF file is saved the entity coordinates and angles
are saved by default to 16 decimal places. You can reduce
the DXF Decimal places in order to reduce the file size but
we recommend that you do not reduce the figure below 8.
We do not recommend reducing this reducing this figure if
the DXF file is the only format saved since you are
irretrievably losing accuracy.
16. DXF files are text format so you may be able to considerably
reduce the file size by not saving trailing zeros on decimal
numbers. To do this tick Remove trailing zeros.
17. Select your Preferred DXF file format bearing in mind that
AutoCAD R14 format does not support line weights and
AutoCAD R12 format does not support the ellipse entity (they
are converted to polylines) or the lightweight polyline entity.
AutoCAD R12 format should be the most portable format. If
you are working with Unicode data then you should use the
AutoCAD 2007 format which is fully Unicode compatible.
18. SavoyCAD is unable to interpret all data held in DXF files
from all sources system. The data it cannot understand it
ignores and so it is lost. We therefore recommend that, if
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you have imported DXF data from another source, you tick
Export only changed and new data to save only the new or
changed data.
19. SavoyCAD needs to know the units you are using in order to
show distances correctly and to plot output to a specified
scale such as 1:200. You will probably draw 1:1 by setting 1
drawing unit equivalent to 1 real world unit (for example,
metre). However, you may from time to time need to read
DXF files that have been generated at some other scale. In
these cases you will need to set 1 Drawing Unit represents
to the appropriate number of real world units.
20. By default SavoyCAD draws entity attributes, including line
weights, as accurately as possible. If you would rather all
lines were drawn in the thinnest line tick Ignore line
weights.
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Preferences: Point Format (1530)
1. Click on the Point Format tab.

Preferences dialog: Point Format tab
2. By default point entities are drawn 0.25 units wide and high
based upon the presumed use of metres. If you are working
in millimetres or inches you may find this too small and wish
to set Point size to, say, 250 millimetres (or, say, 10 inches).
3. Point entities are drawn by default as a cross surrounded by
a circle. You may select an alternative format with optional
surrounding square and or circle.
Note
Any changes to the point format settings applies to all points
in the current drawing including those in imported data and
those in block inserts.
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Preferences: Grid / Snap (1520)
1. Click on the Grid / Snap tab.

Preferences dialog: Grid / Snap tab
2. A grid can optionally be displayed.
3. Set the Grid Origin to the real world coordinates at which
you want the grid to start. Grid lines will be drawn either side
of this point.
4. Set the Grid Spacing to the required horizontal (X) and
vertical (Y) spacing.
5. In addition to the grid a snap grid may be displayed. This is
invisible but you may still adjust the origin and spacing.
6. Set the Cursor Snap Origin to the real world coordinates at
which you want the grid to start. Invisible snap points will be
spaced either side of this point.
7. Set the Cursor Snap Spacing to the required horizontal (X)
and vertical (Y) spacing.
Note
The snap feature is independent of the object snap feature.
21. By default SavoyCAD highlights the entities as the cursor
passes over them. If you are working with a large drawing or
lots of paths SavoyCAD may run slower and you may
therefore want to disable this option by unticking Highlight
the entity under the cursor.
22. If any snap modes are enabled SavoyCAD indicates possible
snap points and types with small icons. If you are working
with a large drawing or lots of paths SavoyCAD may run
slower and you may therefore want to disable this option by
unticking Show snap points and types.
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Preferences: Display (1510)
1. Click on the Display tab.

Preferences dialog: Display tab
2. You can change the display colours to anything you wish. To
change a colour, simply click on the colour swatch. Colours
may be set for the Background, Cursor, Cursor Box, Snap
Marker, Grip, Move Grip, Selected Grip, Grid, Axes Symbol
and Imported Data.
Note
If you set conflicting colours such that for example the cursor
is the same colour as the background the foreground colour
will be changed to ensure that it is visible.
3. Tick Axes symbol to display a coordinate axes symbol in the
bottom left corner of the window. Change the size of the
symbol using the slider.
4. Change the size of the cursor crosshairs using the Cursor
size slider. If you tick Full screen the crosshairs will be
shown extending to the edges of the CAD window.
5. Change the size of the entity editing grips using the Grip
Symbol Size slider control.
6. To enable the display of GripTips (text prompts that appear
as you hover over a grip) tick GripTips.
7. Change the size of the symbol displayed when the cursor
snaps to point using the Snap Symbol Size slider control.
8. Change the size of the grid cross hairs using the Grid
Symbol Size slider control.
9. Tick Hide mouse cursor to hide the arrow pointer while the
cursor is over the drawing window.
10. Click Reset to reset all values to the Savoy defaults.
11. Click OK to confirm changes or Cancel to abort all changes
and close the dialog.
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Preferences: Zoom (1540)
1. Tick on the Zoom tab.

Preferences: Zoom tab
23. If you have a mouse with a scroll wheel then you may want
to tick Zoom on mouse wheel to zoom in and out by turning
the mouse wheel.
By default this zooms in and out on the centre of the CAD
window. If you tick Centre on cursor when zooming in the
zoom in will be centred on the cursor position when the
wheel is turned. This allows for fast movement around the
drawing without the need to pan the drawing. Unsurprisingly,
Centre on cursor when zooming out works the same for
zooming out.
Change the increment using the Zoom on mouse wheel
slider control. This adjusts the zoom factor for each click of
the mouse wheel.
24. Tick Show scroll bars to display scroll bars at the right and
bottom of the CAD window when you zoom such that part of
the drawing is not visible. They allow you to pan sections of
the drawing that are off-screen back into view.
Note
Displaying scroll bars requires more calculation so if you are
finding that there is a time lag every time you draw and
entity, perhaps because you are running on a slow computer
or working with a very large drawing, then you may wish to
try switching off Scroll bars.
2. Click Reset to reset all values to the Savoy defaults.
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Digitising drawings

SavoyCAD has built in support for digitizing tablets allowing you to
electronically “trace” drawings and save them in digital form.

Setting up your digitising tablet
To set up your digitising tablet
1. Make sure that the tablet that you wish to use has WinTab
support.
2. Follow the instructions provided with your digitising tablet to
connect it to your computer.
3. Install the necessary drivers including the WinTab driver.
4. Follow the manufacturers instructions to test the digitising
tablet before trying to use it with SavoyCAD.

Calibrating the tablet
Before you can use your digitising tablet you need to calibrate it. This
process locates the drawing relative to the tablet and allows SavoyCAD
to calculate the real world coordinates of the points you subsequently
pick as you trace your drawing.
The calibration process requires you to identify three points on your
drawing whose coordinates you know accurately. Ideally these points
should be part of the base drawing, e.g. setting out data, in case the
drawing has shrunk or stretched. They should also be as far apart as
possible and preferably form a triangle.
If there are no coordinated points available on the base drawing but you
know the scale of the drawing, then you could plot three points to the
appropriate scale. Note however, that if the drawing has shrunk or
stretched your plotted points will not be accurate and distances (e.g. road
widths) in your digitized drawing may be greater or smaller than they
should be.

To calibrate your tablet (1410)
1. Run SavoyCAD.
2. Select Calibrate from the Tablet drop down menu.
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If you do not have WinTab drivers installed then you will be
warned. Refer to WinTab driver not found.
If SavoyCAD cannot access the digitizing tablet then you will
be warned. Refer to Unable to access digitising tablet.
Otherwise, the Calibrate Tablet dialog will appear.

Calibrate Tablet dialog
3. Using the mouse click Pick Point 1 on Tablet. The text will
change to Picking Point 1 on Tablet.
4. Now, using the digitising tablet puck, carefully select the first
of your reference points. The text on the button will change
to Repick Point 1 on Tablet. If you wish to repick the point at
any time simply click the button again and reselect the point.
5. Enter the real world coordinates of point 1 in the Map
Coords X and Map Coords Y boxes. Notice that the point is
been plotted in red in the window to the right of the buttons.
6. Repeat this process with points 2 and 3 which will be plotted
in the window in green and blue respectively.
7. As soon as you have picked three distinct points the RMS
Error will appear at the bottom of the dialog. Also displayed
is the error expressed as a percentage of the longest
distance. The smaller this value is the more accurately you
have positioned the drawing. If you are not happy with the
accuracy try re-picking the points or selecting different points.
For more information on how to interpret the RMS error refer
to Calibration error.
8. If you tick Zoom to tablet reference point on exit
SavoyCAD will zoom to the extents of your three reference
points when you close this dialog. This allows you to see
subsequently digitised data without having to pan and zoom
first.
9. Once you have calibrated the tablet you may wish to plot
them to the same scale as your original drawing and overlay
it as a double check.
Note
If you move the drawing, remember to recalibrate the tablet
before digitising any more data.
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WinTab driver not found (1600)
1. If SavoyCAD cannot find your WinTab driver, the WinTab
driver not found dialog will appear.

WinTab driver not found dialog
2. Check that you have installed the WinTab device driver
supplied with your tablet.
3. Check that the WinTab driver supports the version of
Windows that you are running. If it does not then try going to
the manufacturers website and searching for a driver that
does.

Unable to access digitising tablet (1610)
1. If SavoyCAD is unable to find a digitizing tablet connected to
your computer, the Tablet not found dialog will appear.

Digitising tablet not found dialog
2. Check that the tablet is plugged into the computer and
switched on.
3. Test the tablet if possible according to the manufacturers
instructions.

Calibration error
SavoyCAD only really requires two points to be able to position the
drawing. The third point is requested for confirmation and in order to
calculate likely error. The error at each point is calculated by first backcalculating point 1 from points 2 and 3, point 2 from points 1 and 3 and
finally point 3 from points 1 and 2. The distance between the calculated
coordinates and the actual coordinates is then calculated for each point.
The RMS error is then the square root of the mean of the squares of
these distances. It is best expressed thus:-

RMS Error = SQRT((δ1^2 + δ2^2 + δ3^2)/3)
Where:-

δ1
δ2
δ3
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is error at Point 1
is error at Point 2
is error at Point 3
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The error will normally be significantly less than 1%. However, the
calibration calculation assumes equal distortion in the X and Y directions,
so if your drawing is stretched in one direction only you may get higher
errors.
Warning
You may get apparent high degrees of accuracy even when making
considerable errors in picking the points as long as the triangle formed by
the picked points forms a scale version of the true triangle. We therefore
recommend that you view the RMS error as a guide rather than as an
absolute criteria.

Seeing your reference points
You may, at some point after you have calibrated the tablet, need to
remind yourself which points you used. To do this:1. Select Show tablet points from the View drop down menu.
The last three digitizing tablet reference points used will be
plotted on your drawing.

Digitising data
The same commands are used to trace a drawing as are used to draw
entities from scratch but using the tablet puck instead of the mouse. So
for example:-

To digitise a point
Point button

1. Select Point from the Draw drop down menu or click
Point on the Draw toolbar or type POINT on the command
line. You will be prompted for the point.
2. Pick the Point using the digitising puck. The point will
appear in your chosen format (which may render it almost
invisible!).
Note
You can change the appearance of point entities in the
Preferences dialog.

To digitise a line

Line button

1. Select Line from the Draw drop down menu or click Line
on the Draw toolbar or type LINE on the command line.
You will be prompted for the start point.
2. Pick the first point of the line using the digitising puck. The
point will be placed and a line displayed connecting it to
the cursor position. You will be prompted for the end
point.
3. Pick the end point using the puck. The line will appear
selected.
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To digitise a polyline
Polyline button

1. Select Polyline from the Draw drop down menu or, using the
mouse, click on the Polyline button on the Draw toolbar or
type PLINE on the command line.
2. Now, using the digitising tablet puck pick the first point on the
line. Button 1 on the puck is usually the select button but, if
in doubt, refer to your tablet’s instructions.
3. Move the cursor to the next point and pick that.
4. If you want to trace an arc, type A (for arc) on the command
line. The line connecting the last point to the cursor will
change to an arc and the command line prompt will change.
Now, using the puck, pick the end point.
If you want to revert to line segments, type L (for line) on the
command line. The arc connecting the last point to the
cursor will change to a line and the command line prompt will
change. Pick the next point using the puck.
5. Repeat the process until you have traced the whole line.
6. You can close the line by typing CL on the command line or
finish by clicking button 2 or the confirm button.

To digitise a circle
Circles can be drawn in two ways; by defining three points on the
circle or by defining the centre and radius.

To digitise a 3-Point Circle
3-Point Circle button

1. Select Circle: 3 Points from the Draw drop down menu or
click 3-Point Circle on the Draw toolbar or type
CIRCLE3P on the command line. You will be prompted for
the first point.
2. Pick the first point on the circle using the digitising puck.
At this stage nothing will be visible. You will be prompted
for the second point.
3. Pick the second point on the circumference of the circle
using the puck. Now you should see a circle drawn
through the two defined points which changes radius and
position as you move the cursor. You will be prompted for
the third point.
4. Pick the third, and final, point using the puck. The full
circle will now appear selected.

To digitise a Centre/Radius Circle
Centre/Radius button

1. Select Circle: Centre / Radius from the Draw drop down
menu or click Centre/Radius Circle on the Draw toolbar
or type CIRCLE on the command line. You will be
prompted for the centre of the circle.
2. Pick the centre point using the digitising puck. A circle will
appear whose radius changes as you move the mouse.
You will be prompted for the radius of the circle.
3. Pick a point on the circumference of the circle using the
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puck. The circle will now appear selected.

To digitise an arc
1. Select Arc: 3 Points from the Draw drop down menu or
click Arc on the Draw toolbar or type ARC on the
command line. You will be prompted for the start point.

Arc button

2. Pick the start point of the arc using the digitising puck. At
this stage nothing will be visible. You will be prompted for
the middle point.
3. Pick the middle point using the puck. An arc will appear
whose shape changes as you move the mouse. You will
be prompted for the end point.
4. Finally, pick the end point of the arc using the puck. The
completed arc will appear selected.

To digitise an ellipse
It may not be easy to accurately digitise an ellipse unless you
can fairly precisely identify the ends of the major and minor axes.
1. Select Ellipse from the Draw drop down menu or click
Ellipse on the Draw toolbar or type ELLIPSE on the
command line. You will be prompted for the centre of the
ellipse.

Ellipse button

2. Pick the centre of the ellipse using the digitising puck. At
this stage nothing will be visible. You will be prompted for
the major axis point.
3. Pick one end of the major axis using the puck. At this
point an ellipse will appear whose shape changes as you
move the cursor. You will be prompted for the minor axis
point.
4. Pick one end of the minor axis using the puck. The
completed ellipse will appear selected.
Note
Although the ends of the axes are requested in a particular
order (major axis first), you may select a minor axis point
that makes it the longer of the two.

Tools to help you
Digitised drawings can appear very disjointed, especially if you need to
move the map and recalibrate the tablet. However, some of the featuires
in SavoyCAD may be used to eliminate some of these problems.

Snap modes
If you have to stop and restart digitising a line you can end up with a gap.
You can prevent these kinds of discontinuities by using snap to end. You
may other snap modes useful. For example, snap to centre may be used
if you need to digitise circles concentric circles. Simply toggle the
appropriate snap mode and move the digitising puck close to the required
point. Refer to Object Snap modes (Object Snap Modes dialog) for how
to set snap modes.
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Zoom
Zoom may be used at any time to magnify an area and make it easier to
see the data you are digitising. Just use Zoom Previous to return to the
previous zoom level.
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Glossary of Terms

Absolute coordinates
Coordinates expressed as values independent of any other coordinates.

ATX file
The native file format of AutoTrack.

Axes Symbol
A symbol that indicates the direction of the X and Y coordinate axes.

Cursor
A crosshairs marker similar to the standard Windows arrow cursor that
indicates the current position of the mouse.

Cursor Box
The square surrounding the cursor crosshairs.

Digitising tablet
A device used to electronically trace printed graphics into digital form.
They range in size from A4 up to A0.

Docked
A window or toolbar is said to be docked when it appears to be attached
to the frame of the parent window. Objects may be docked against any
side of the window frame.

DXF
Stands for Drawing eXchange Format. A file format developed by
Autodesk but now used by most CAD systems to exchange data.

Entity
In the context of SavoyCAD and entity is a visible or sometimes invisible
object that forms part of a drawing.

User Manual for SavoyCAD

Glossary of Terms  67

Extents
The furthest point of any entity in each direction. Zoom Extents to view
everything in your drawing.

Explode
Reduce an object (e.g. a block or a polyline) to its constituent entities.

Floating
A window or toolbar is said to be floating when it does not appear
attached to the frame of parent window.

Frozen
A term used in layer management. See Frozen layer.

Frozen layer
All entities on a Frozen layer are invisible. The same would be true if the
layer were Off.

Grid
A rectilinear array of crosses at specified horizontal and vertical intervals
superimposed on the drawing.

Grip
Small squares that appear at each edit point on an entity when it is
selected. Grips can be selected and moved using the mouse.

Import
To add data and entities from an external file into the current drawing.

Imported Data
Drawing entities that have been loaded into the current drawing using the
Import command.

Insert point
The datum point in a block that is used when insertion it into a drawing.

Insertion point
The point at which a block or text is inserted.

Layer
A means of grouping objects together. The properties of layers (e.g.
visibility) may be controlled independently of the objects they include.
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Locked
A term used in layer management. See Locked layer.

Locked layer
The entities on a locked layer may not be edited.

Major axis point
The two points (one at each end) at the intersection of the major axis of
an ellipse and the ellipse itself.

Minor axis point
The two points (one at each end) at the intersection of the minor axis of
an ellipse and the ellipse itself.

Move Grip
A move grip is the grip used to move an entity. Every entity has a move
grip.

Object Snap
The ability of the cursor to move to an object that is within a certain
distance without the user having to precisely position it.

Polyline
A line made up of any number of line and arc segments.

Puck
The input device connected to a digitizing tablet. Similar to a mouse but
with crosshairs to enable accurate selection of points.

Relative coordinates
Coordinates expressed as distances from the last point by prefixing the
ordinate(s) with the @ symbol.

Scroll bar
Scroll bars appear at the side and / or bottom of the CAD window if you
zoom in such that part of the drawing is not visible. They allow you to
pan the window horizontally and vertically.

Selected Entity
An entity that has been selected for editing. Selected entities appear in a
special colour and always have at least a move grip visible.

Selected Grip
A grip that has been selected by moving the mouse over it and clicking.
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Snap
The ability of the cursor moves to a given position when it is within a
certain distance without the user having to precisely position it.

Snap Grid
A rectilinear grid to which the cursor may optionally snap. The Snap Grid
is not the same as the Grid.

Snap Symbol
A symbol that appears at a potential snap point when the cursor is within
a specified distance.

Snap Point
The point that the cursor snaps to when it gets within a certain distance.

SVC file
The native file format of SavoyCAD.

Toolbar
A toolbar is a row of buttons that provide shortcuts to menu commands.

WinTab
WinTab is a device driver standard for graphical input devices. The
WinTab driver for a particular device allows all WinTab compliant
applications to access the device.

WTP file
The native file format of WinTrack.
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B
Blocks & Inserts 18, 28

Maintain Layers dialog (1000) 33
Maintain Linetypes dialog (1100) 36
Manual layout 1
Measuring distances (Distance command) 49
Menus 3
Mid Point 48
More on object snap modes 47
Mouse conventions 1

C
Calibrating the tablet 59
Calibration error 61
Centre Point 48
Colours list 38
Context sensitive on-line help 2

N
Nearest Point 48
Notation conventions 1

O

Digitising data 62
Drawing 20

Object Snap modes (Object Snap Modes dialog)
(1200) 47
Opening vs Importing files 7
Orthogonal mode 46

E

P

Editing 24
End Point 48
Entering values 17
Example 19

Perpendicular Point 48
Preferences (Preferences dialog) 51
Preferences: Display (1510) 56
Preferences: General (1500) 52
Preferences: Grid / Snap (1520) 55
Preferences: Point Format (1530) 54
Preferences: Zoom (1540) 57
Previewing your printed output (Print Preview
screen) 11
Printer / Plotter Settings: Notes (1300) 16
Printer / Plotter Settings: Print Settings (1310) 13
Printer / Plotter Settings: Title Block (1320) 15
Printing (Plotter / Printer Settings dialog) 12

D

F
File handling 7
Fundamentals of drawing & editing 17

G
General 3
Getting help 2
Glossary of Terms 67
Grid 45
Grip editing 27
GripTips 27

H
Help 5
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S
Seeing your reference points 62
Selecting / deselecting objects 17
Setting up your digitising tablet 59
Snap grid 45
Snap modes 64

Index  71

T
Tangent Point 48
To automatically repeat the last command 23
To automatically use the last point drawn 23
To calibrate your tablet (1410) 59
To change a layer's name 32
To change the colour of an object 38
To change the current layer 34
To change the current linetype 37
To change the grid colour 45
To change the grid spacing 45
To change the line weight of an entity 39
To change the linetype of an entity 35
To change the snap grid colour 46
To change the snap grid origin or spacing 46
To change to colour of a layer 32
To clear drawing limits 43
To copy an object 25
To create a block 28
To create a new layer 32, 34
To create a new linetype 35, 37
To delete a layer 34
To delete a linetype 37
To delete an object 26
To digitise a 3-Point Circle 63
To digitise a Centre/Radius Circle 63
To digitise a circle 63
To digitise a line 62
To digitise a point 62
To digitise a polyline 63
To digitise an arc 64
To digitise an ellipse 64
To display a grid 45
To draw a 3-Point Circle 21
To draw a Centre/Radius Circle 21
To draw a circle 21
To draw a line 20
To draw a point 20
To draw a polyline 20
To draw an arc 22
To draw an ellipse 22
To draw text 22
To enable orthogonal mode 46
To explode a block 29
To explode a polyline 23
To export a DXF file 9
To go back to the previous zoom window 42
To go forward to the next zoom window 42
To import a DXF, ATX or SVC file 9
To insert a block 28
To make a layer invisible 31
To make a layer non-editable 32
To move a toolbar 4
To move an object 25
To move an object to another layer 31
To move an object using grips 27
To open a drawing file 7
To pan across the the drawing 43
To redraw all entities 41
To reset any rotation 43
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To resize / reshape an object 27
To resize the command window 4
To rotate an object 26
To rotate the drawing 43
To save a copy of a file 9
To save a drawing file 8
To set drawing limits 43
To set up your digitising tablet 59
To snap to the snap grid 45
To start a new drawing 7
To stop a layer from being printed 32
To switch toolbars on and off (Toolbars dialog)
(1420) 3
To view the coordinates of an object (List command)
24
To view the properties of an object (Properties
dialog) (1400) 24
To zoom in 41
To zoom out 41
To zoom to a specific area 42
To zoom to the drawing extents 42
To zoom to the drawing limits 42
To zoom to the tablet limits 42
Toolbars 3
Tools to help you 64
Tooltips 5

U
Unable to access digitising tablet (1610) 61

W
What it can and can't do 1
WinTab driver not found (1600) 61

Z
Zoom 65
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